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1 Introduction

West LiveNote Administration is used in conjunction with West LiveNote Repository to manage access 
to West Case Notebook or West LiveNote cases that are shared across a network. You add West Case 
Notebook or West LiveNote cases and users to the repository, then you manage access to the cases by 
assigning attributes to both the cases and the users through West LiveNote Administration. 

Notes

• You must install and license West LiveNote Repository before using West LiveNote Administration.

• The cases added to the repository are called secure cases. Only secure cases can be shared across a 
network. There are two types of secure cases:

• managed cases to which only authorized users have access and you, as the administrator, control 
the level of access for each user in each case

• unmanaged cases to which all users have access

• Users are assigned seats for West Case Notebook or West LiveNote and West LiveNote Remote 
Access Server (RAS). A seat allows the user to access and share cases on the network. See 
”Information on User Settings” on page 5 for more information about seats.

• If you are working on a secure case with other users, all users must use the same version of West 
Case Notebook or West LiveNote. For example, if your are working in West LiveNote version 2.0 or 
West Case Notebook version 2.0, then all users working on the case must use West LiveNote version 
2.0 or West Case Notebook version 2.0.

• If you are working in West Case Notebook 2.0 or West LiveNote 2.0, then revert to using West Case 
Notebook version 1 or West LiveNote version 1, you must manually rebuild the search index for the 
case. To rebuild the search index, choose Advanced, Rebuild Search Index from the Tools menu.
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Preliminary Steps
After you install West LiveNote Repository and West LiveNote Administration, you must complete the 
licensing requirements for West LiveNote Repository before you can access West LiveNote 
Administration. To license West LiveNote Repository, complete these steps:

1. Access West LiveNote Administration. The Repository License Installation dialog box is displayed 
(Figure 1-1).

Figure 1-1. Repository License Installation dialog box

2. Type a name for the repository, e.g., San Francisco, in the Repository Name text box. 

3. Click Next. The Create an Administrator Account dialog box is displayed (Figure 1-2).

Figure 1-2. Create an Administrator Account dialog box

4. Type a username, e.g., Admin, in the Username text box. This is the username you, as the 
administrator, will use to access West LiveNote Administration.

5. Type your first name in the First Name text box.

6. Type your last name in the Last Name text box.

7. Type a password in the Password and Confirm Password text boxes. This is the password you will 
use to access West LiveNote Administration.



Introduction      3

8. Click Next. The Repository Licensing Complete dialog box is displayed (Figure 1-3).

Figure 1-3. Repository Licensing Complete dialog box

9. Click Finish. The West LiveNote Administration window is displayed.
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Using the West LiveNote Administration Window
The West LiveNote Administration window contains tabs for cases, users, and groups. Depending on 
the tab that is displayed, information for the cases, users, or groups in the repository is displayed in the 
left pane. The details for a particular case, user, or group are displayed in the Active View pane on the 
right. 

For example, on the Cases tab in Figure 1-4 below, the left pane shows 

• the names of the cases in the repository 

• the location of the cases

• the client-matter numbers, if available 

The Active Case View pane on the right displays the details for a particular case, including

• the name of the case

• whether the case is managed ( ) or unmanaged ( )

• groups added to the case

• users added to the case

• users who have replicated the case offline

• users who currently have the case open

Figure 1-4. West LiveNote Administration window
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2 Working with Users

When you add a user to West LiveNote Administration, you assign seats, a user type, a user state, and 
permissions to the user. 

Information on User Settings

SEATS

Seats are obtained when you purchase West Case Notebook, West LiveNote, or RAS and become 
available when you license your secure cases repository. When you create a user account, the user is 
automatically allocated a seat for West Case Notebook, West LiveNote, or RAS if available. Only users 
who have been assigned a seat can access secure cases.

Note You can reassign seats when there are changes in staff and you can purchase more seats when 
no seats are available. To reassign the license for a seat or purchase new seats, contact West 
LiveNote Customer Support at 1-800-290-9378 .

USER TYPES

You assign a user type to designate the level of access a user has to a secure case. 

• External User. External users have the lowest level of access to cases. (For example, you may want 
to give external user status to clients or experts who are not a part of the organization.) They can 

• view transcripts, linked documents, and videotaped depositions

• search the full text of transcripts and linked documents and print them

• set options for West Case Notebook, West LiveNote, or RAS

When working on a case offline, external users can

• create new transcripts and connect to a real-time deposition

• create and delete Auto Tags

• update and delete transcripts created while the case is offline

Note Offline changes made by external users are not replicated back to the network case.

• Reader User. Reader users can perform all external user tasks. They also can

• view all annotations, Issue Marks, and Quick Marks

• view and print reports

• search annotations

Note Offline changes made by reader users are not replicated back to the network case. 
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• Author User. Author users can perform all reader user tasks. They also can

• create annotations, Issue Marks, and Quick Marks

• edit annotations

• create, edit, and delete new issues in cases that have been replicated offline

Note Offline changes, except changes to Auto Tags, made by author users are replicated back to 
the network case.

• Editor User. Editor users can perform all author user tasks. They also can edit and delete 
annotations, Issue Marks, Quick Marks, and reports created by others.

Editor users cannot

• when working on an offline case, edit or delete annotations created by other users 

• when working on a network case, edit or delete annotations created by another user who has 
replicated the case offline

Note Offline changes, except changes to Auto Tags, made by editor users are replicated back to 
the network case.

• Power User. Power users can perform all editor user tasks. They also can

• create and manage transcripts and transcript groups

• open a network case and connect to a real-time deposition, then manage the case index and 
thesaurus

Power users cannot

• when working on a network case, edit the annotations created by another user who has 
replicated the case offline

• when working on an offline case, edit annotations created by other users; create, edit, or delete 
transcript groups; edit the properties of existing transcripts; or delete existing transcripts

• Case Manager. Case managers manage all aspects of a case that affect all users. They also can

• create and manage issues, annotations, Quick Marks, and Auto Tags

• edit case properties

Note All users are automatically given case manager status in unmanaged cases, regardless of 
their user type in managed cases.

USER STATES

You assign a user state to designate the level of activity for a user.

• User is active. This state enables the user to access secure cases, provided the user has a seat for 
the product.

• User is not active. This state prevents the user from accessing secure cases.

Note If you change a user’s state to inactive, the user’s annotations in a transcript are preserved in 
the user’s name. If you delete a user, all of the user’s annotations are labeled as “unknown.” 
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USER PERMISSIONS

You assign permissions to designate the level of privileges for a user.

• Administrative Privileges. Administrative privileges allow the user to use West LiveNote 
Administration. For example, you may want to give administrative privileges to litigation support or 
technical staff.

• Power Editor. This permission is available only when the user has a case replicated offline. It 
enables the user to modify others users’ annotations, Quick Marks, and Issue Marks. When the user 
replicates the case back to the network, any changes the user has made override the existing 
annotations, Quick Marks, and Issue Marks.

Note Assign this permission with extreme caution. The work product of other users may be lost 
when replicating the case back to the network.

• Replicate Case. This allows the user to replicate cases offline. It is selected by default. You can 
remove this privilege for all or only certain cases.
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Adding Users
To add a user to West LiveNote Administration, you must create an account for the user. When you 
create a user account, you assign a seat, user type, user state, and permissions to the user. 

To create a user account, complete these steps:

1. Click the Add User button ( ) on the toolbar at the top of the West LiveNote Administration 
window. The Add New User dialog box is displayed (Figure 2-1).

Figure 2-1. Add New User dialog box

2. Type a username, e.g., johns, in the Username text box.

3. Type the user’s first name, e.g., John, in the First Name text box.

4. Type the user’s last name, e.g., Smith, in the Last Name text box.

5. Type the user’s password, e.g., password, in the Password and Confirm Password text boxes.

6. Select the User cannot change password check box if you do not want the user to change the 
password. 

7. Select the User must change password at next logon check box if you want the user to change the 
password when he or she logs on for the first time.

8. Under Default permissions, choose Case Manager, Power User, Editor User, Author User, Reader 
User, or External User from the User Type drop-down list. See ”Information on User Settings” on 
page 5 for information on user types and other user settings. 

9. Choose either User is active or User is not active from the User State drop-down list. 

10. Under Additional User Permissions, select the Administrative Privileges or Power Editor check box, 
if desired. 

11. Clear the Replicate Case check box, if desired.

12. Under Allocate, clear the West LiveNote Seat or RAS Web Seat check box, if desired. 

Note If there are not enough seats for the user, the check box will be unavailable. 

13. Click OK. The user is added to the list of users in the repository on the Users tab in the left pane 
and details for the user are displayed in the Active User View pane on the right.
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Assigning, Reassigning, and Removing Seats
When you create a user account, the user is automatically allocated a seat if any are available. You may, 
however, need to assign, reassign, or remove seats after you create a user account. 

To assign, reassign, or remove a user’s seat, complete these steps:

1. Click the Users tab in the lower-left corner of the West LiveNote Administration window 
(Figure 2-2). The users in the repository are displayed in the left pane. 

Figure 2-2. Users tab

2. Select or clear the check boxes next to the user’s name in the West LiveNote or RAS Web Seat 
column to assign, reassign, or remove a user’s seat.

Changing User Details
You can change the information for a user such as the username, first name, last name, password, user 
type, user state, or permissions. To change this information, complete these steps:

1. Click the Users tab in the lower-left corner of the West LiveNote Administration window. The users 
in the repository are displayed in the left pane.

2. Right-click the user for which you want to change the information and choose Edit from the 
displayed menu. The Edit User dialog box is displayed (Figure 2-3).

Figure 2-3. Edit User dialog box

3. Make your changes and click OK. 
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Deleting a User
To delete a user, complete these steps:

1. Click the Users tab in the lower-left corner of the West LiveNote Administration window. The users 
in the repository are displayed in the left pane.

2. Right-click the user you want to delete and choose Delete from the displayed menu. 

3. A message asking whether you are sure you want to delete the selected user is displayed. Click Yes. 
The user is permanently removed from the repository. 

Note  If you delete a user, all of the user’s annotations are labeled as “unknown.”
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3 Working with Groups

You can create a group that contains a number of users. You can then add the group to a case, rather 
than adding the users individually to a case.

Note If a user is a member of a group and you change the user’s type or permissions, those changes 
will apply to any case to which that group is assigned.

Creating a Group
To create a group, complete these steps:

1. Click the Add Group button ( ) on the toolbar at the top of the West LiveNote Administration 
window. The Add New Group dialog box is displayed (Figure 3-1).

Figure 3-1. Add New Group dialog box

2. Type a name for the group, e.g., Insurance Team, in the Group Name text box.

3. Click OK. The group is added to the list of groups on the Groups tab in the left pane and the details 
for the group are displayed in the Active Group View pane on the right. 

Changing the Name of a Group
To change the name of a group, complete these steps:

1. Click the Groups tab in the lower-left corner of the West LiveNote Administration window. The 
groups in the repository are displayed in the left pane.

2. Right-click the group for which you want to change the name and choose Edit from the displayed 
menu. The Edit Group dialog box is displayed.

3. Type a new name in the Group Name text box.

4. Click OK. 
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Adding and Removing Users

ADDING USERS TO A GROUP

To add users to a group, complete these steps:

1. Click the Groups tab in the lower-left corner of the West LiveNote Administration window. The 
groups in the repository are displayed in the left pane.

2. Double-click the group to which you want to add users. The group is displayed in the Active Group 
View pane on the right.

3. Click the Users tab in the lower-left corner of the West LiveNote Administration window. The users 
in the repository are displayed in the left pane (Figure 3-2). 

4. Select the users you want to add to the group. Use one of the following methods to add the users 
to the group:

• Drag the users to the Users folder in the Active Group View pane on the right.

• Right-click the users and choose Add to active group from the displayed menu.

Figure 3-2. Users tab

REMOVING A USER FROM A GROUP

To remove a user from a group, complete these steps:

1. Click the Groups tab in the lower-left corner of the West LiveNote Administration window. The 
groups in the repository are displayed in the left pane.

2. Double-click the group from which you want to remove users. The group is displayed in the Active 
Group View pane on the right.

3. Right-click the user you want to remove in the Users folder in the Active Group View pane and 
choose Remove from active group from the displayed menu. 

Deleting a Group
To delete a group, complete these steps:

1. Click the Groups tab in the lower-left corner of the West LiveNote Administration window. The 
groups in the repository are displayed in the left pane.

2. Right-click the group you want to delete and choose Delete from the displayed menu. 

3. A message asking whether you are sure you want to delete the selected group is displayed. Click 
Yes. The group is permanently removed from the repository. 

Users 
folder
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4 Working with Cases

With West LiveNote Administration, you can

Creating a New Case
To create a new case, complete these steps:

1. Click the New Case button ( ) on the toolbar at the top of the West LiveNote Administration 
window. The Add New Case dialog box is displayed (Figure 4-1). 

Figure 4-1. Add New Case dialog box

2. Type the name of the case, e.g., Celms v Federated Insurance, in the Case Name text box.

3. Type the location for the case in the Case Path text box. In the alternative, click Browse to display 
the Select the Location of the Case dialog box. Select the location for the case and click Save.

4. The case name is entered by default in the File Name text box. If desired, change the file name.

5. Select the Managed check box if you want to manually add users and groups to the case.

6. Type a client-matter number in the Client-Matter text box, if desired.

7. Type a comment in the Case Comments text box, if desired. 

8. Click OK. Your case is added to the list of secure cases in the repository on the Cases tab.

• create a new case

• import one case or several cases

• add and remove users

• add and remove groups

• set cases as replicated to the network or 
offline

• set case-based user type and permissions

• change case details

• move a case

• delete a case
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Importing a Case
You can import a case created in West Case Notebook or West LiveNote into West LiveNote 
Administration to create a secure case. If the case you are importing contains annotations, you must 
assign a user as the author of the annotations.

Note If you do not want to assign a current user as author of all the annotations or do not know the 
author of the annotations, you can create a fictitious user, e.g., Historical Annotations, to assign 
as author of the annotations. This will ensure the annotations are available for use on the 
network. See ”Setting Cases As Replicated to Offline or to the Network” on page 20 for more 
information on online use.

To import a case, complete these steps:

1. From the Case menu, choose Import. In the alternative, click the Import Case button ( ) on the 
toolbar at the top of the West LiveNote Administration window. The Select the Case to Import 
dialog box is displayed. 

2. Click Browse to display the Browse for a Local Case dialog box (Figure 4-2).

Figure 4-2. Browse for a Local Case dialog box

3. Go to the folder where your West Case Notebook or West LiveNote cases are located and select the 
.lnp file for the case you want to import, e.g., Bowler_v_Cabot.lnp. 

4. Click Open. The Select the Case to Import dialog box is redisplayed.

5. Click Next. If the case includes annotations, the Select an Owner dialog box is displayed 
(Figure 4-3).
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Figure 4-3. Select an Owner dialog box

6. Choose a name from the Owner drop-down list, e.g., Historical Annotations, and click Next. The 
Select the Destination Location dialog box is displayed (Figure 4-4).

Figure 4-4. Select the Destination Location dialog box

7. Type a different case name in the Case Name text box, if desired.

8. Type a different location in the Case Path text box, if desired.

9. Type a different case file name in the Case File text box, if desired.

10. Under Case Details, select the Managed check box if you want to manually add users and groups to 
this case.

11. Type a client-matter number in the Client-Matter text box, if desired.

12. Type a comment in the Case Comments text box, if desired

13. Click Next to display the Import Completed dialog box.

14. Click Finish. Your case is added to the list of secure cases in the repository on the Cases tab.
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Importing a RealLegal Binder Case
You can import a RealLegal Binder case, version 5 or later, into West LiveNote Administration 
version 1.1 or later. To import a RealLegal Binder case, complete these steps:

1. From the Case menu, choose Import. In the alternative, click the Import Case button ( ) on the 
toolbar at the top of the West LiveNote Administration window. The Select the Case to Import 
dialog box is displayed. 

2. Click Browse to display the Browse for a Local Case dialog box.

3. Go to the folder where your RealLegal Binder cases are located and select the .pxl file for the case 
you want to import. 

4. Click Open. The Select the Case to Import dialog box is redisplayed.

5. Click Next. The Select the Destination Location dialog box is displayed.

6. Type a case name in the Case Name text box.

7. Type a different location in the Case Path text box, if desired.

8. Type a different case file name in the Case File text box, if desired.

9. Under Case Details, select the Managed check box if you want to manually add users and groups to 
this case.

10. Type a client-matter number in the Client-Matter text box, if desired.

11. Type a comment in the Case Comments text box, if desired

12. Click Next to display the Import Completed dialog box.

13. Click Finish. Your case is added to the list of secure cases in the repository on the Cases tab.
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Importing Several Cases
You can import several cases at once using the batch import function. You can import a group of cases 
or import a folder that contains cases. 

To import several cases at once, complete these steps:

1. From the Case menu, choose Batch Import. The List of Cases to Import dialog box is displayed. 

2. Click one of the following:

• Add cases. The Select One or More Case Files to Import dialog box is displayed. Select the .lnp 
files for the cases you want to import and click Open. The List of Cases to Import dialog box is 
displayed. 

• Add folder. The Browse for Folder dialog box is displayed. Select the folder that contains the 
cases you want to import and click OK. The List of Cases to Import dialog box is displayed.

3. Click Next. The Select an Owner dialog box is displayed. 

4. Select one of the following:

• I want to choose an owner for all cases now. Choose a name from the Owner drop-down list.

• I want to be prompted for an owner as each case is imported. 

5. Click Next. The Select the Destination Location dialog box is displayed. 

6. Type a different location for the cases in the Case Path text box, if desired.

7. Click Next. West LiveNote Administration begins importing the cases. 

8. If you specified in Step 4 that you wanted to choose an annotation owner for each case as it is 
imported, the Select an Owner for Any Applicable Items in Case dialog box is displayed for each 
case. Choose a name from the Owner drop-down list and click OK. 

9. Once the cases have been imported, the Batch Import Completed dialog box is displayed. If 
desired, click Save Report to save a report of the batch import. The Save the List of Files That Did 
Not Import to dialog box is displayed. 

10. Select the location for the report and click Save.

11. Click Finish. The cases are added to the list of cases on the Cases tab.
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Adding and Removing Users

ADDING USERS TO A CASE

A managed case can only be accessed by the users and groups added to it in West LiveNote 
Administration. When you add a user to a case, West LiveNote Administration gives the user a default 
user type and permissions, which you can change. See ”Setting Case-Based User Type and 
Permissions” on page 21 for more information.

Note You do not need to add users or groups to an unmanaged case. All users in the repository are 
automatically given access to the case with Case Manager status.

To add users to a case, complete these steps:

1. Click the Cases tab in the lower-left corner of West LiveNote Administration window. The cases in 
the repository are displayed in the left pane.

2. Double-click the case to which you want to add users. The case is displayed in the Active Case View 
pane on the right. 

3. Click the Users tab in the lower-left corner of the West LiveNote Administration window. The users 
in the repository are displayed in the left pane (Figure 4-5). 

4. Select the users you want to add to the case. Use one of the following methods to add the users to 
the case:

• Drag the users to the Users folder in the Active Case View pane on the right.

• Right-click the users and choose Add to active case from the displayed menu.

Figure 4-5. Users tab

REMOVING A USER FROM A CASE

To remove a user from a case, complete these steps:

1. Click the Cases tab in the lower-left corner of West LiveNote Administration window. The cases in 
the repository are displayed in the left pane.

2. Double-click the case from which you want to remove users. The case is displayed in the Active 
Case View pane on the right. 

3. Right-click the user you want to remove in the Users folder in the Active Case View pane and 
choose Remove from active case from the displayed menu. 

Users 
folder
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Adding and Removing Groups

ADDING A GROUP TO A CASE

You can also add a group to a case. Each user in the group will have access to the case. If you add a 
group to a case and change a group member’s user type and permissions for that case, those changes 
will also apply to other cases to which that group is added. 

To add a group to a case, complete these steps:

1. Click the Cases tab in the lower-left corner of West LiveNote Administration window. The cases in 
the repository are displayed in the left pane.

2. Double-click the case to which you want to add the group. The case is displayed in the Active Case 
View pane on the right. 

3. Click the Groups tab in the lower-left corner of the West LiveNote Administration window. The 
groups in the repository are displayed in the left pane (Figure 4-6). 

4. Select the group you want to add to the case. Use one of the following methods to add the group 
to the case:

• Drag the group to the Groups folder in the Active Case View pane on the right.

• Right-click the group and choose Add to active case from the displayed menu.

Figure 4-6. Groups tab

REMOVING A GROUP FROM A CASE

To remove a group from a case, complete these steps:

1. Click the Cases tab in the lower-left corner of West LiveNote Administration window. The cases in 
the repository are displayed in the left pane.

2. Double-click the case from which you want to remove the group. The case is displayed in the Active 
Case View pane on the right. 

3. Right-click the group you want to remove in the Groups folder in the Active Case View pane and 
choose Remove from active case from the displayed menu. 

Groups 
folder
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Setting Cases As Replicated to Offline or to the Network
West Case Notebook or West LiveNote users can replicate a case offline for use off the network. Users 
can also replicate the case back to the network, or online. See ”Replicating Cases Offline and to the 
Network” on page 36 for more information. In some situations, such as when a computer is stolen or 
has technical problems, you may need to set a case for a user as replicated to offline or to the network. 
To set a case as replicated to offline or to the network, change the case user to offline or online status.

SETTING CASES AS REPLICATED TO OFFLINE

To set a case as replicated to offline, complete these steps:

1. Click the Cases tab in the lower-left corner of the West LiveNote Administration window. The cases 
in the repository are displayed in the left pane.

2. Double-click the case for which you want to change the user’s status. The case is displayed in the 
Active Case View pane on the right. The users with access to the case are listed in the Users folder.

3. Right-click the user you want to change to offline status and choose Mark this user offline in the 
repository from the displayed menu (Figure 4-7). The user is added to the Offline Users folder.

Figure 4-7. Displayed menu

Note When a user replicates a case offline, the user’s annotations in the case are not available to other 
users on the network. Others users can run reports and search and view the annotations of the 
offline user but cannot edit or delete them.

SETTING CASES AS REPLICATED TO THE NETWORK 

To set a case as replicated to the network, complete these steps:

1. Click the Cases tab in the lower-left corner of the West LiveNote Administration window. The cases 
in the repository are displayed in the left pane.

2. Double-click the case for which you want to change the user’s status. The case is displayed in the 
Active Case View pane on the right. The users who are currently working on the case offline are 
listed in the Offline Users folder.

3. Right-click the user you want to change to online status and choose Mark this user online in the 
repository from the displayed menu (Figure 4-8). The user is removed from the Offline Users 
folder.
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Figure 4-8. Displayed menu

Setting Case-Based User Type and Permissions
You can set special permissions for one or more users for a managed case that is particularly sensitive 
or requires strict user access. See ”Information on User Settings” on page 5 for more information on 
user types and permissions.

Note To set case-based user types or permissions, you must add the user to the case individually, not 
as a member of a group. 

CHANGING THE USER TYPE ONLY

To change the user type only, complete these steps:

1. Click the Cases tab in the lower-left corner of the West LiveNote Administration window. The cases 
in the repository are displayed in the left pane.

2. Double-click the case for which you want to set case-based user types. The case is displayed in the 
Active Case View pane on the right.

3. The users with access to the case are listed in the Users folder. Right-click the user whose type you 
want to change. Choose Set user type from the displayed menu, then choose Case Manager, 
Power User, Editor User, Author User, Reader User, or External User from the submenu 
(Figure 4-9). The user type for the user is changed for this case only. The user type does not change 
for the user on the Users tab or in a group. 

Figure 4-9. Displayed menu
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CHANGING THE USER TYPE AND PERMISSIONS

1. Click the Cases tab in the lower-left corner of the West LiveNote Administration window. The cases 
in the repository are displayed in the left pane.

2. Double-click the case for which you want to set case-based user types and permissions. The case is 
displayed in the Active Case View pane on the right.

3. The users with access to the case are listed in the Users folder. Right-click the user whose user type 
and permissions you want to change. Choose Edit from the displayed menu (Figure 4-10). The Edit 
User dialog box is displayed.

Figure 4-10. Displayed menu

4. Under Case permissions, choose Case Manager, Power User, Editor User, Author User, Reader 
User, or External User from the User Type drop-down list. 

5. Under Additional User Permissions, select or clear the Administrator Privileges, Power Editor, and 
Replicate Case check boxes. 

6. Click OK.
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Changing Case Details
You can change the information for a case such as the case name, location, client-matter number, and 
comments and whether the case is managed or unmanaged. 

To change the details of a case, complete these steps: 

1. Click the Cases tab in the lower-left corner of the West LiveNote Administration window. The cases 
in the repository are displayed in the left pane.

2. Right-click the case for which you want to change the case information and choose Edit from the 
displayed menu. The Edit Case Properties dialog box is displayed (Figure 4-11).

Figure 4-11. Edit Case Properties dialog box

3. To change the case name, location, client-matter number, or comment for the case, type the new 
information in the text boxes.

4. To change the managed status of the case, select or clear the Managed check box. 

5. Click OK.

Note If you change the status of a case to

• managed, a message is displayed stating that any previously assigned users or groups have 
been restored to the managed case 

• unmanaged, a message is displayed stating that all users will have access to this unmanaged 
case and that previously assigned users and groups will be restored if the case is set as managed 
again
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Moving a Case
You can move a case to another location, if desired. To move a case, complete these steps:

1. Click the Cases tab in the lower-left corner of the West LiveNote Administration window. The cases 
in the repository are displayed in the left pane.

2. Right-click the case you want to move and choose Move from the displayed menu. The Select 
Where You Want to Move Case dialog box is displayed.

3.  Select the new location for the case and click Save.

Deleting a Case
To delete a case, complete these steps:

1. Click the Cases tab in the lower-left corner of the West LiveNote Administration window. The cases 
in the repository are displayed in the left pane.

2. Right-click the case you want to delete and choose Delete from the displayed menu. 

3. A message asking whether you are sure you want to delete the case is displayed. Click Yes. The 
case is permanently removed from the repository. 
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5 Changing the Ownership of 
Annotations, Auto Tags, and Key Facts

Users who are case managers can change the ownership of annotations and Auto Tags for West 
LiveNote cases and the ownership of annotations, Auto Tags, and key facts for West Case Notebook 
cases. Changing ownership would be necessary if, for example, the owner is no longer working on a 
case. To change the owner of annotations, Auto Tags, and key facts, complete these steps:

1. Click the Cases tab in the lower-left corner of the West LiveNote Administration window. The cases 
in the repository are displayed in the left pane.

2. Select the case for which you want to change the ownership of the annotations, Auto Tags, and key 
facts.

3. From the User menu, choose Change Ownership. The Change Owner dialog box is displayed 
(Figure 5-1).

Figure 5-1. Change Owner dialog box

4. The current owner of the annotations, Auto Tags, and key facts is displayed in the From box. 
Choose a different name, e.g., John Smith, from the To drop-down list.

5. Click OK. 
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6 Working with Active Directory 
Authentication

Active Directory authentication allows West Case Notebook or West LiveNote users to use their network 
usernames and passwords when accessing cases through West LiveNote Administration. Active 
Directory authentication compares the usernames and passwords in West LiveNote Administration with 
usernames and passwords in the Windows Server 2003, Windows Server 2008, or Windows Server 
2008 R2 Active Directory. 

Notes

• Active Directory authentication is not compatible with LiveNote Enterprise Server version 9. 

• Before you, as an administrator, enable Active Directory authentication, your username and 
password must be added to Active Directory. 

• Before you enable Active Directory authentication, West Case Notebook or West LiveNote users 
must be listed in Active Directory and must know their usernames and passwords. 

• You can use the LiveNote Admin Tool to schedule an automatic update of groups and users from 
Active Directory. For more information on this feature, see ”LiveNote Admin Tool” on page 41.
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Importing Groups and Users from Active Directory
To import groups and users from Active Directory, complete these steps:

1. From the Repository menu, choose Import Group/User List. The Select the Import Source dialog 
box is displayed (Figure 6-1).

Figure 6-1. Select the Import Source dialog box

2. Select Import from Active Directory and click Next. The Select the Users to Import dialog box is 
displayed (Figure 6-2).

Figure 6-2. Select the Users to Import dialog box

3. Choose a group, e.g., Litigation, from the Active Directory Group drop-down list at the top of the 
dialog box, if desired. The users in the group are listed in the dialog box. If you do not want to 
include a user, clear the check box to the left of the user’s name. 

4. Click Next. The Select Default User Settings dialog box is displayed.

Note The information in this dialog box is applied to all imported users.
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5. Under Default permissions, choose a user type and user state from the User Type and User State 
drop-down lists. See ”Information on User Settings” on page 5 for information on these and other 
user settings. 

6. Under Additional user permissions, select the Administrative Privileges check box or clear the 
Replicate Case check box, if desired.

7. Under Allocate, select the West LiveNote Seat or RAS Web Seat check box, if desired.

8. Type a password in the Default Password and Confirm Password text boxes. This creates the same 
password for all imported users. 

9. Clear the User cannot change password check box, if desired. Because you are giving all imported 
users the same password, it is recommended that you clear this check box. 

10. Select the User must change password at next logon check box, if desired. Because you are giving 
all imported users the same password, it is recommended that you select this check box.

11. Click Next. The Select the Groups to Import dialog box is displayed (Figure 6-3). This dialog box 
relates to the Select the Users to Import dialog box. For example, if you selected the Litigation 
group in the Select the Users to Import dialog box and then select the same group in this dialog 
box, a group called Litigation is created with the specified users when the Active Directory is 
imported.

Figure 6-3. Select the Groups to Import dialog box

12. Click Finish. The Group/User List Import dialog box is displayed (Figure 6-4).



30      Working with Active Directory Authentication

Figure 6-4. Group/User List Import dialog box

13. Click Close. The users are added to the repository and listed on the Users tab.

Enabling Active Directory Authentication
To enable Active Directory authentication, complete these steps:

1. From the Options menu, choose Default Options. The Default Options dialog box is displayed 
(Figure 6-5). 

Figure 6-5. Default Options dialog box

2. Select the Authenticate users against Active Directory check box.

3. Click OK. One of the three following messages is displayed:

• WARNING: Enabling Active Directory authentication means users must use their Active Directory 
username and password to access LiveNote and/or LiveNote Administration. Enabling Active 
Directory authentication without first configuring your repository could result in users not having 
access to LiveNote and/or LiveNote Administration. Do you want to continue? 

Click Yes. 
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• WARNING: The administrative user ‘your username’ does not currently exist in Active Directory. 
Enabling Active Directory Authentication means an Active Directory username and password are 
required to access the Repository. Because you do not have an Active Directory username and 
password, you will be unable to access Repository and LiveNote Administration. Do you want to 
continue? 

Click No. Add your username and password to Active Directory, and create an account for yourself 
with the same username and password used in LiveNote Administration. Otherwise, the next time 
you log on to LiveNote Administration, you will be locked out. 

• ERROR: Enabling Active Directory authentication means an Active Directory username and 
password are required to access the Repository. Currently, no LiveNote administrators have an 
Active Directory username and password. Create a LiveNote administrator username and 
password for a user in Active Directory and enable Active Directory authentication. 

Click Close. Add your username and password to Active Directory, and create an account for 
yourself with the same username and password used in West LiveNote Administration. 
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7 Working with West Case Notebook or 
West LiveNote

You interact with West LiveNote Administration when you access secure cases in West Case Notebook 
or West LiveNote. Below are features and settings in West Case Notebook or West LiveNote that apply 
to West LiveNote Administration.

Accessing Secure Cases
To access secure cases in West Case Notebook or West LiveNote, complete these steps:

1. Access West Case Notebook or West LiveNote. Or in an open case, choose Open Case from the File 
menu. The Open Case dialog box is displayed (Figure 7-1).

Figure 7-1. Open Case dialog box

2. Click Repositories. The Repositories dialog box is displayed 
(Figure 7-2).

Figure 7-2. Repositories dialog box

3. Select the repository that you want to log on to and click Logon. The Logon to [Repository Name] 
dialog box is displayed (Figure 7-3).
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Figure 7-3. Logon to [Repository Name] dialog box

4. Type your username and the password that is assigned to you in West LiveNote Administration in 
the Username and Password text boxes. 

5. Select the Remember my logon settings check box if you want West Case Notebook or West 
LiveNote to remember your username and password.

6. Click OK. The Repositories dialog box is redisplayed (Figure 7-4).

 
Figure 7-4. Repositories dialog box

7. Click Close. The Open Case dialog box is redisplayed with a list of the cases to which you are 
assigned (Figure 7-5).

 
Figure 7-5. Open Case dialog box

Note Two types of folders may be displayed: 

•  A brown folder indicates a local case or a secure case that is currently being accessed through the 
network. 

• A blue folder indicates a secure case that was replicated offline and is currently being accessed 
locally. 
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To view only secure cases, choose List Cases by Repository from the drop-down list at the top of 
the dialog box, then click the plus symbol (+) next to the repository containing the cases you want 
to view.

8. Select your case and click OK. 

Viewing a List of Favorite Secure Cases
When you access secure cases in West Case Notebook or West LiveNote, all of the cases to which you 
are assigned are listed in the Open Case dialog box. You can add one or more of these cases to your list 
of favorite cases, then view only those cases when you access West Case Notebook or West LiveNote. 

To view your list of favorite cases, complete these steps:

1. Access secure cases. The Open Case dialog box is displayed with a list of the cases to which you are 
assigned (Figure 7-6). 

Figure 7-6. Open Case dialog box

2. Right-click the case you want to add to your list of favorite cases, e.g., Clelland v Anderson, and 
click Add to My Favorite Cases.

3. Choose List My Favorite Cases from the drop-down list at the top of the dialog box. Your list of 
favorite cases is displayed (Figure 7-7).

Figure 7-7. List of favorite cases
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Replicating Cases Offline and to the Network

REPLICATING A CASE OFFLINE

You can work on a secure case off the network by replicating the case offline in West Case Notebook or 
West LiveNote. To replicate a secure case that you are currently working on offline, complete these 
steps:

1. From the File menu, choose Replicate Case Offline. The Replication Wizard–Case Data dialog box 
is displayed (Figure 7-8).

Figure 7-8. Replication Wizard–Case Data dialog box

2. By default, all document types and datatranscripts and documents are selected. To exclude a 
document type from being replicated offline, clear its check box. To exclude particular data from 
the report, click the document type containing the data, then clear the check boxes for the data you 
want to exclude.

3. Click Groups to add the data you selected to a data group. The Data Groups dialog box is 
displayed. Select the group to which you want to add the data and click OK. 

Note You can use groups to organize data into folders under data categories in the left pane. 

4. Click Finish. The Cases Replicated to Offline dialog box is displayed, informing you that the case 
was successfully replicated offline. 

5. Click one of the following:

• Open Case. The case is displayed in the left pane.

• Close. The case is closed.
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REPLICATING A CASE TO THE NETWORK

To replicate a case you are currently working on to the network, complete these steps:

1. From the File menu, choose Replicate Case Online. The Cases Replicated to Network dialog box is 
displayed.

2. Click one of the following:

• Open Case. The case is displayed in the left pane.

• Close. The case is closed. 

REPLICATING MULTIPLE CASES OFFLINE

To replicate multiple cases offline, you must first change your replication options, then close West Case 
Notebook or West LiveNote and select the cases you want to replicate offline. To replicate multiple cases 
offline, complete these steps:

1. Choose Options from the Tools menu. The Options dialog box is displayed.

2. On the Confirmation tab, select the Replicate offline on closing West LiveNote check box, then 
click OK.

3. Close West Case NotebookLiveNote. The Replication Wizard–Cases dialog box is displayed 
(Figure 7-9).

Figure 7-9. Replication Wizard–Cases dialog box 

4. By default, all the cases on the network that are assigned to you are selected. To exclude a case 
from being replicated offline, clear its check box.

5. Click Next. The Replication Wizard–Case Data dialog box for the first case you selected is 
displayed. 
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6. By default, all document types and datatranscripts and documents are selected. To exclude a 
document type from being replicated offline, clear its check box.

7. Click Groups to add the data you selected to a data group. The Data Groups dialog box is 
displayed. Select the group to which you want to add the data and click OK.

8. Click Next. If you selected more than one case, the Replication Wizard–Case Data dialog box for 
the next case you selected is displayed.

9. Repeat steps 6–8 for each case you want to replicate offline.

10. When you have finished selecting the document types for all the cases you want to replicate offline, 
click Finish. The Cases Replicated to Offline dialog box is displayed, informing you that the cases 
were successfully replicated offline.

11. Click Close. West Case NotebookLiveNote is closed.

REPLICATING MULTIPLE CASES TO THE NETWORK

1. If you replicated cases offline, the next time you access West Case Notebook or West LiveNote, the 
Replication Wizard–Offline Cases dialog box is displayed (Figure 7-10).

Figure 7-10. Replication Wizard–Offline Cases dialog box

2. By default, all the cases that you replicated offline are selected. To exclude a case from being 
replicated to the network, clear its check box.

3. Click Finish. The Cases Replicated to Network dialog box is displayed.

Figure 7-11. Cases Replicated to Network dialog box 
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4. Select a case, then click one of the following:

• Open Case. The case is displayed in the left pane.

• Close. The case is closed. 

Changing Replication Options
West Case Notebook or West LiveNote has replication options that prompt you to replicate the case 
offline when you close West Case Notebook or West LiveNote or replicate the case to the network when 
you open West Case Notebook or West LiveNote. To change these options, complete these steps:

1. From the Tools menu, choose Options. The Options dialog box is displayed (Figure 7-12).

Figure 7-12. Options dialog box

2. Select the Replicate offline on closing West LiveNote check box, if desired.

3. Clear the Replicate to the network on opening West LiveNote check box, if desired.

4. Make your selection the default, if desired.

5. Click OK. 
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8 LiveNote Admin Tool

The LiveNote Admin Tool is a command line tool that allows you to schedule an automatic updating of 
groups and users in the West LiveNote Repository from Active Directory. You can also specify user 
settings and assign West Case Notebook or West LiveNote seats. To use the Admin Tool, you create a 
batch file and then use Microsoft Windows Scheduled Tasks to implement it.

Creating a Batch File
You can create a batch file using any text editor, e.g., Microsoft Notepad. Then save the batch file with a 
.bat extension. Below are the switches used in a batch file for the Admin Tool.

• username/password – username and password for the West LiveNote Repository administrator.

• /SERVER:hostname[:port] – name and port for the West LiveNote Repository. If this parameter is 
not specified, Admin Tool will look for a default repository in the user section of the registry.

• /USERS – imports all users in the Active Directory.

• /USERGROUP:group1[group2].... – imports all users in the specified group. Also, a group will be 
created in the repository that corresponds to the Active Directory group.

• /DEFAULTPASS:pw – specifies the default password assigned to each user. If the repository is 
configured to authenticate users using Active Directory, this parameter will be ignored.

• /USERTYPE:ExternalUser|ReaderUser|AuthorUser|EditorUser|PowerUser|CaseManager – assigns 
a user type to each user.

• /ADMINPRIV – assigns administrator privileges to each user.

• /REPLICATEPRIV – assigns replication privileges to each user.

• /POWEREDITORPRIV – assigns power editor privileges to each user.

• /LNSEAT – allocates a West Case Notebook or West LiveNote seat to a user if a seat is available.

• /LNRASWEBSEAT – allocates RAS Web seat to a user if seat is available.

• /d – disables user in repository when Active Directory is updated if user is diabled in Active 
Directory.

• /c – imports all user names from Active Directory in lower case; users must use all lower case when 
logging on.

SAMPLE BATCH FILE

@ECHO OFF

REM Changes the current directory to the directory where the Admin Tool is located,
REM runs AdminTool.exe, logs in with the administrator’s username and password,
REM imports an Active Directory group called “Sales,” and
REM assigns a LiveNote seat to all users in the group.
CD C:\Program Files\West LiveNote\West LiveNote Administration
ADMINTOOL user1/password1 /USERGROUP:Sales /LNSEAT

END BATCH FILE
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Using Scheduled Tasks
To implement the batch file using Scheduled Tasks, complete these steps:

1. From the Start menu, choose Control Panel. The Control Panel window is displayed.

2. Double-click Scheduled Tasks. The Scheduled Tasks window is displayed.

3. Double-click Add Scheduled Task. The Scheduled Task Wizard is displayed.

4. Click Next.

5. Select the batch file you created and click Next.

6. Type a name for the task in the text box and select the frequency at which you want to update the 
repository. Click Next.

7. If you selected Daily, Weekly, Monthly, or One time only as the frequency in Step 6, select the day 
and time you want the update to start. Click Next.

8. Type your network username in the Enter the user name text box and type your network password 
in the Enter the password and Confirm password text boxes. Click Next.

9. Select the Open advanced properties for this task when I click Finish check box, if desired. Click 
Finish. The Scheduled Tasks window is redisplayed.

10. Click the Close button in the upper-right corner of the window.










